
History of program changes and enhancements from 2014-2019 

 

2019 

Module Program/Feature Description Notes Date 

Core System Maintenance Print Employee Records includes Security Level code. 
 

3/2019 

POS POS- Gratuity Option to disable gratuity button on total/payment screen MENUINI.FIL  line: POS-GRATUITY-BUTTON=NO 4/2019 

POS POS- Payment tip The payment code setup field "Allow tip entry?" (cash) can 
be set to "N" for any payment code. 

If set to "N" the "Tip Amount prompt does not appear when 
tendering the check; if set to "Y" the "Tip Amount" prompt displays. 4/2019 

POS POS- Auto Gratuity Auto Gratuity button acts as a toggle button to add/not add Touch once adds gratuity, touch again removes gratuity. 5/2019 

POS POS Modifiers Includes % modifier (such as half, double, etc.) In Modifier setup, Price add-on/subtract amount: option to enter as 
percent. For example: Half (50%) - enter 50, Double (200%) - enter 
200, etc.  Answer Y to “Above amount is a percentage?” 

3/2019 

Interface Comtrol Interfaces More detailed error messages 
 

4/2019 

Interface QuickBooks Interface QuickBooks Import File (IIF) is included in the Email Audit 
Reports function 

 
4/2019 

Other Direct Bill / City Ledger Employee ID prints on the Transaction Batch update report 
 

3/2019 

Other Direct Bill / City Ledger Customer setup has option to add notes 
 

3/2019 

Other Direct Bill / City Ledger Customer Detail Report - option to create a tab delimited 
text file 

Can be imported into Excel 3/2019 

Other Time & Attendance Timeclock printout shows terminal number 
 

3/2019 

Other ExecEmail Button on the Print Preview button "Email" Sends the report on the Print Preview as an email.  Must use 
ExecEmail.  Does not work with Outlook. 4/2019 

Other General Ledger/ AP Set a GL account to inactive so that A/P invoices cannot be 
distributed to that account. 

 
4/2019 

Other General Ledger GL Trial Balance has an export option Select the check box "Create TAB delimited text file only".  File 
exported is named GLTRBAL**.FIL (** is the terminal number). 1/2019 

 

 

 

 

 



2018 

Module Program/Feature Description Notes Date 

Hotel Reservations - 
AutoPost 

Option to select Auto-Post charges in Reservations. MENUINI.FIL line: 
HOTEL-AUTOPOST-RESERVATIONS=YES 

1/2018 

Hotel Charge/ Payment 
Journal 

Guest History Charge/ Payment Journal prints Market Segment and Source of 
Business for all transactions 

GAHJOUR 10/2018 

POS Check Summary 
Report 

Addition to Check Summary Report to print only checks with tips. 
 

3/2018 

POS POS - Void CC 
preauthorization 

Allows supervisor password requirement to void preauthorization in POS MENUINI.FIL line: 
POS-REQUIRE-PASSWORD-VOID-PREAUTH=YES 

5/2018 

Interface Security Updates for 
TLS 1.2 

Required security updates for customers with integrated credit card processing. See TLS 1.2 Requirements 4/2018 

Interface Wifi Interface Comtrol interface to Antamedia to allow/restrict guest wifi access and optional 
billing.   
See https://www.antamedia.com/   
See https://www.comtrol.com/solutions/hospitality/lodginglink. 

Comtrol is required for this and all device 
interfaces. 

2/2018 

Other General Ledger - 
Report Export 

General Ledger Detail Report screen has a new checkbox "Create TAB delimited 
file only" 

 
10/2018 

Other Direct Bill Report Optional report listing all RC* charges for any unpaid City Ledger invoices from 
folios w/ DB payment types. 

Specific report for specific purpose. 1/2018 

 

2017 
Module Program/Feature Description Notes Date 

Hotel Packages Addition of percent tax (ST*) to Resort Fee Must be on line immediately after the resort fee.  Special code is 
9.  Amount is the percent. 

10/2017 

Hotel Night Audit Default room/item average on AM Report Change default "revenue average" from "per room" to "per item".  Still can 
be selected manually when printing.  Requires MENUINI.FIL command. 

8/2017 

Hotel Night Audit Popup notification upon completion of program. Notification when the following program has completed:  "Create Gen 
Ledger/City Ledger Postings" (Night Audit) 

8/2017 

Hotel PMS Popup notification upon completion of program. Notification when the following program has completed:  GARESYNC (On 
Demand or shortcut) 

8/2017 

Hotel PMS Search for guest by boat name Boat Name (or any other search) should be in Folio Comment 2.  See also 
Marina and RV Settings. 

7/2017 

Hotel Night Audit Email night audit reports (YYYYMMDD.TXT) Run from night audit menu; up to four pre-defined email addresses.  Uses 
ExecEmail.  See MENUINI.FIL Configuration. 

6/2017 



Hotel Execu/Suite PMS - 
Groups 

A/R customer code required for DB payment code 
 

5/2017 

Hotel Execu/Suite PMS - 
Folio email 

Option to set default to email folio at check-out 
 

5/2017 

Hotel Marina Import meter readings from CSV (Canvas) 
 

4/2017 

POS Report Update to "Items by server/dept/menu/shift" report to 
calculate gallons for "FUEL" items. 

 
10/2017 

POS Check Detail Report Check Detail Report - Option to print Guest Name for 
account/room charges. 

 
10/2017 

POS Activity Log Inventory item additions and deletions; Inventory Batch 
adjustments and deletions. 

Listed in "Print POS/Timekeeping Reports" in the Activity Log menu. 10/2017 

POS Inventory "Notes" added to inventory Item setup. "Notes" button at bottom of item setup screen. 10/2017 

POS Inventory Control Option to use barcode when entering physical inventory To use with wireless scanner or compatible mobile tablet or other device 6/2017 

POS Item Report Kitchen Description added to POS item report 
 

6/2017 

Interface Vantiv Credit Card 
Processing 

EMV certification with Vantiv Integrated Payments Certification for Lodging, Food & Beverage, and Retail 11/2017 

Interface OTA/HTNG Enhancements to Reservations Import Interfaces 
 

4/2017 

Interface Shift4 Credit Card 
Processing 

Shift4 EMV certification for lodging Update must be coordinated with Shift4 update. 3/2017 

Other Execu/Gift Ability to disable "Service Charge" entry in "Add 
Balance" screen 

Remove GCH (or your designated code) from MENUINI.FIL setting. 12/2017 

Other General Ledger - 
Reports 

Option to print acct codes on Balance Sheet 
 

11/2017 

Other Time & Attendance Clock-in Terminal Clocks POS users in ONLY At this terminal, POS users will not access any POS programs even if 
employee type is other than N.  Terminal Record should show Terminal 
Location as L. 

11/2017 

Other Time & Attendance Disallow POS supervisor to edit own time. Requires MENUINI.FIL  command. 10/2017 

Other General Ledger 
Processing 

Option to add/change/review/delete transactions in GL 
batches on other terminals; option to update batches on 
other terminals. 

New menu item in General Ledger Processing > Enter transactions: 
“Change transaction terminal”. 

10/2017 

Other General Ledger Popup notification upon completion of program. Notification when the following program has completed:  "Create Excel™ 
Spreadsheet File" (General Ledger) 

8/2017 

Other Direct Bill Date validation for membership billing Prevents entering through Date field and creating invalid postings on Fixed 
Charges 

3/2017 

Other Back Office - Payroll Configured for Bahamas Wage and Tips NIB deductions plus Employer NIB 2/2017 

 



2016 

Module Program/Feature Descrip�on Notes Date 

Hotel Security Levels Allow change to "out of order" status in Housekeeping  12/2016 

Hotel Folio Detail Export Ability to save Transac�ons in Guest Trial Balance as *.txt file to import into Excel. See Folio Detail Export 10/2016 

Hotel Guest Profile Fi�h tab has been added (top right Profile screen).  Title it in Manager/Setup .  8/2016 

Hotel Group Check-in Group check-in by selec�on grid.  Reserva�ons for the group will display, allowing 
you to click the reserva�ons to check in or "select all".  Only those selected will 
check in with the group. 

 6/2016 

Hotel Tape Chart Reserva�ons with Rate codes 6 and 7 display pink.  Rate code is displayed next to 
room rate upon right-click 

 6/2016 

Hotel Guest Trial Balance 
Report 

Guest Trial Balance shows available credit/funds  5/2016 

Hotel Tape Chart Op�on to reduce ver�cal size of grid boxes, allowing more rooms to display per 
page. 

See MENUINI.FIL configura�on 5/2016 

Hotel Tape Chart - Travel 
Agencies 

Indicator (small orange box) displayed on tape chart for Travel Agency bookings.  5/2016 

Hotel Room Rates Report "Print room rates" added to "Print Charge/ Payment/ Misc. Codes" menu.  5/2016 

Hotel Ac�vity Logs Improvements to func�onality and display for Ac�vity Logs  4/2016 

Hotel Security Levels Allow / Disallow check-in and check-out of master folios  4/2016 

Hotel Guest Schedule Ability to export Guest Schedule as spreadsheet For proper�es using Guest Schedule 3/2016 

Hotel ETConnect Addi�on of  automated pre-arrival leters and automated thank-you leters a�er 
check-out 

For proper�es using Execu/Suite Connect 2/2016 

Hotel Travel Agency Report Commission % added to travel agency report  1/2016 

POS To-Go quick buton Op�onal "to go" buton on POS item entry screen.   Prompts for name (or room 
number) and prompts for pre-defined loca�on. 

See MENUINI.FIL Configura�on for loca�on 
defini�ons. 

5/2016 

POS Import/Export of 
setup data 

POS modifiers added to POS import/export program Import/Export via tab-delimited text files 5/2016 

POS Register Programs & 
Controls 

"Register Programs and Controls" added to POS Administrator System menu.  5/2016 

POS GAPOCOPY Added ability to copy items or modifiers store to store  5/2016 

POS Inventory/POS Op�on to overwrite exis�ng items when crea�ng inventory items from POS items INPOGEN 3/2016 

POS Inventory/POS Allows items to be scanned in POS using the Vendor Item Code (field 2) as the UPC 
barcode number. 

Only works with newly entered Vendor Item 
Codes. 

9/2016 

Interface Phone Interface Enhancement to Execu/Suite Wake-up Calls w/ NEC interface  5/2016 



Interface SynXis/Sabre 
Interface 

Modifica�ons to match new data import format  5/2016 

Interface Shi�4 Credit Card 
Processing 

Enhancement of i4GoV2 registry and controls. 
Enhancement of i4GoV2 messages and errors. 

 5/2016 

Interface Shi�4 Credit Card 
Processing 

Implementa�on of i4GoV2 to replace current version of Shi�4 interface Required update for proper�es using Shi�4 3/2016 

Interface Van�v Credit Card 
Processing 

Enhancements to Van�v/ElementPS batch reports For proper�es using Van�v/ElementPS 3/2016 

Interface Comtrol® Interface Modifica�on to Onity key interface for connec�ng rooms Comtrol Onity Interface 1/2016 

Interface GMS (Guest 
Management) 

New interface to ZDirect GMS/Replaces TravelClick GMS GMS/CRS Interface 1/2016 

Other Direct Bill Report Modifica�on to Customer Aged Trial Balance to handle 9,999,999.99  8/2016 

Other Execu/Vault New features added to Execu/Vault func�onality For customers using Execu/Vault 8/2016 

Other Online Help "Online Help" quick-click buton added to Reserva�ons Opera�ons, Front Desk, 
Guest History, and Direct Bill/Customer Processing menus. 

 5/2016 

Other Execu/Gi� - POS POS Gi� Card sales - Next sequence number auto-generated if card is not swiped 
or card number not entered. 

For proper�es using Execu/Gi� 5/2016 

Other Execu/Gi� Addi�on of notes, type, and status in Gi� Card Trial Balance For proper�es using Execu/Gi� 3/2016 

Other Exec/Email Clarifica�on of ExecEmail response messages and errors N/A if using Outlook 1/2016 

 

2015 

Module Program/Feature Description Program Name Date 

Core Login Printer selection dialog opens immediately at login instead of when opening one of the programs.  Only displays 
once per user login. 

 11/2015 

Core Login Login screen displays current computer time rather than the time the shortcut was launched. START 10/2015 

Core System Maintenance- 
User Setting 

New security levels settings: 
1. Allow transfers (in charge and payment posting) 
2. Disable activity log pop-up warning 

MENUCNTL  

Core System Maintenance- 
User Setting 

New option, "Allow credit limit changes and overrides".  Unchecked, an employee is not allowed to change a 
guest's credit limit except by adding to a preauthorization on an existing credit card authorization.  Also 
unchecked, allows an employee to override the "Credit limit exceeded" prompt in charge/payment entry with O or 
0.  Checked, will allow. 

  

Core Help menu The Help menu now contains only "About".  Links formerly in the Help menu are now on the main Execu/Suite 
home screen. 

  

Hotel Autopost Option to calculate Autopost as percentage of room rate.  Multiple percentage Autopost charge codes may be set 
up. 

 7/2015 



Hotel Report Viewer ETReportviewer.exe via desktop shortcut enables viewing and printing of archived night audit reports  9/2015 

Hotel Housekeeping Report Option to exclude Vacant Clean (VC) rooms from Housekeeping Report GAHKEEP 9/2015 

Hotel Housekeeping Screen 

1. Each out of order grid line displays a line or "sequence" number as a visual aid.   
2. Both old and new values are recorded in the Activity Log. 
3. If a line that includes the current date is removed or replaced, a warning is displayed, and the room status is 
changed to VD (Vacant Dirty).   This will give immediate feedback that a line was overwritten. 

  

Hotel Report Generator "Travel Agent" has been added to the "Select" list.  When entering the travel agent code, use only 2 
characters.   The Travel Agent code prompt pops up after the travel agency has been entered. 

 4/2015 

Hotel Guest Profile The "Save" button has been replaced with "Save/Exit". 
The "Exit" button and the "Esc" keyboard key prompts the user to exit without saving. 

  

Hotel Guest Profile "View Stays" within the profile entry screen is a button at the top of the screen.   

Hotel Guest Profile - Auto 
Traces 

In a reservation, optional automatic creation of traces based on definitions.  The auto-trace adjusts automatically 
when the reservation's arrival date is changed.  The auto-trace is deleted automatically when the reservation is 
cancelled. 
 
The definitions are defined in Manager/Setup > Hotel Control Files Setup > Auto-trace definitions. 

GARMAINT 1/2015 

Hotel Manager - Rate 
Import Now allows up to 20 room types GARATIMP 1/2015 

Hotel Registration Form Parameter Record setting for print reg card option:  "a" will not ask, "print another one?"   

Hotel Reserv. & Front Desk There is a lookup button next to the rate code field in the package selection popup.   

Hotel Reservations 

Option not to populate the reservation Market and Source from the profile's Market and Source (except WebRes 
bookings.) Each reservation would have to have Market and Source populated. 
 
MENUINI.FIL command: HOTEL-RES-USE-PROFILE-MARKET-SOURCE=NO 
(The default is YES.) 

  

Hotel Tax- Bahamas Bahamas VAT tax is calculated.   

POS Store Record Store Record - print option - receipt comment 
Ability to add second comment to printed receipt. 

 10/2015 

POS Time Clock Report Option to print by employee name GAPOEMPR 3/2015 

POS Total Screen-Tax 
An option to replace the "No Tax" button with the "Select Tax" button.   
 
MENUINI.FIL command: POS-SELECT-TAX=YES 

GAPOREG 1/2015 

POS Total Screen 
Additional Tip description 
 
MENUINI.FIL command: POS-ADDL-TIP-DESC=ADD'L GRATUITY (OPTIONAL) 

GAPOREG 1/2015 

POS Tax - Bahamas Bahamas VAT tax is calculated   

POS Check Total screen 
password 

A supervisor password is required to total a credit check (a check less than zero).  This option is set by answering 
"Y" to "Password to create credit?" in the Store Record in POS Administrator. 

 3/2015 



POS POS Void Report POS Void Report now includes totals.  11/2015 

Other Dining Reservations The Dinner Reservations module is now integrated to WebRes, allowing guests to book dinner seating on your 
website. 

  

Other File Uploader If Execu/Tech support cannot connect remotely to your server, you can use this program to upload files requested 
by Execu/Tech in order to troubleshoot. 

  

Other Execu/Condo Prevents running "Transfer room charges to CONDO" at night audit more than once per day GACONDO 9/2015 

Interface HTNG Log Viewer ETHTNGLogViewer.exe will read the log files created by the HTNG interface.  11/2015 

Interface TravelClick CRS New profile is created and attached to reservation when a reservation name is changed in imported TravelClick 
reservations. GARIMPTC 8/2015 

Interface TravelClick CRS 

For a TravelClick reservation coming from a third party, Comment 3 of the reservation will have the following 
format: 
 
168868781 3Pty=4444455556 

  

Interface Element (Vantiv) 
Credit Card Tokens 

ElementPS only:  Automatic purge of payment records after a pre-defined number of days for guest history and for 
all others.  
 
MENUINI.FIL command: ELEMENT-PURGE-DAYS=30,270 
 
(where "30" is number of days for guest history and "270" is the number of days for others.) 

 1/2015 

Interface SafLok key Comtrol 
Interface 

Ability for SafLok key interface to specify additional locks for additional guests.  In addition to asking for number of 
keys, a check box will appear allowing selection of access to additional lock.  If a garage key is selected, the system 
may trigger a garage charge.  The garage charge must be set as an auto-post charge code. 
 
MENUINI.FIL commands: 
     KEY-INTERFACE=COMTROL 
     KEY-INTERFACE-LOCKS=Parking Garage,Sauna,Weight Room,Media Room 
 
(Note that there are not spaces before or after the commas.) 

  

 

 

 

 

 

 

 



2014 

Module Program/Feature Description Program(s) Date 

Hotel CHECK OUT THANK YOU 
EMAIL 

Guests may now receive an automatic "Thank You" email message at check-out.  
 
A separate template is required (GAGELET.HTM.) 

GAGELET 12/2014 

Hotel DINING RESERVATIONS - 
WEB BOOKING Using the same technology as WebRes for hotel reservations, works real-time with dining reservations database. GAWRDES 12/2014 

Hotel DIRECT BILL Open Item Payment Processing - Prompt for "beginning date" when displaying past invoices. ARMMAINT 12/2014 

Hotel EMAIL CONFIRMATION 
LETTER 

Expand property name on template.   
 
MENUINI setting: COMPANY-LONG-NAME=* 

GARLETTE 12/2014 

Hotel EXECU/SUITE SQL AM Report Statistics and POS check history ARE now included in the Execu/Suite SQL database in addition to 
Guest Profiles and Reservations. 

GASTAT 
GAPOTXT 12/2014 

Hotel GIFT CARDS/ 
CERTIFICATES 

New option to allow creation of gift certificates/ cards without linking to a profile for either the "From" or "To" 
name. GAGIFT 12/2014 

Hotel MARINA - ELECTRIC AND 
WATER METER READIING 

Room (slip) rate setup is no longer affected by meter readings. This makes setting up meter codes and room 
rates more streamlined. 

GAMETBIL   
GAGMETER 
GACMAINTW 

12/2014 

Hotel NIGHT AUDIT BACK 
OFFICE POSTING 

New, clearer message is displayed: "General Ledger and/or Direct Bill (City Ledger) entries will now be created 
from Night Audit." GAGLU 12/2014 

Hotel NIGHT AUDIT 
REORGANIZE 

New popup message:  
"Your NIGHT AUDIT CUT-OFF TIME is (time). 
Do not perform the night audit for (business date) before (time). 
Current time is (current time). Run this program only ONCE per day! 
No other transactions or activity is allowed until Night Audit Reorganize is complete. This activity may result in 
severe data corruption. All other workstations MUST be at the 'login' screen or the Windows 'Desktop'." 

GAFINAL 12/2014 

Hotel TAPE CHART Now identifies three additional reservation categories: Comp, Travel Agency guaranteed, and Travel Agency non-
guaranteed. GARMAINT 12/2014 

Hotel TRAVEL AGENCY 
PROCESSING 

GATRMAST - Agency setup now provides for a separate IATA field. 
GATRREP - IATA number now prints on detail report. 

GATRMAST 
GATRREP 12/2014 

Hotel TRAVEL AGENCY 
PROCESSING 

GATRONYX - Interface Travel Agency payment processing to Onyx. 
 
Must also have GATRMAST and GATRREP 

GATRONYX 12/2014 

Hotel USER ID PERMISSION 
SETUP 

New permission level: "Allow Webres page editing" used to accommodate the new Execu/Suite Webres user 
page editor. MENUCNTL 12/2014 

Hotel EVENTS CONTROL FIL 
PRINT Print event items, categories, or departments. GAMTCTLR 9/2014 



Hotel GENERAL LEDGER 
INCOME STATEMENTS 

GL Income/expense print sequences may now be alphanumeric, giving more flexibility in formatting income 
statements. 

GLMMAINT 
GLPL 9/2014 

Hotel GUEST REPORT 
GENERATOR User may select "Nights" totals to be "Guest nights" or "room nights". GAHREP 9/2014 

Hotel GUEST TRIAL BALANCE 
REPORT Correct prior day reports by printing in folio sequence instead of name. GAGTRBAL 9/2014 

Hotel HOUSEKEEPING SCREEN "Refresh" button and display date and time stamp. GACRMST 9/2014 

Hotel ROOM REVENUE 
RECONCILIATION REPORT 

New report prints charge and payment journal detail by room from in-house and history guests.  Designed 
primarily for CONDO reconciliation. GADETREP 9/2014 

Hotel SAFELOK KEY INTERFACE Safelok key interface now works with Comtrol. GAINPASS 
GAMMAINT 9/2014 

Hotel TRAVEL AGENCY SETUP Separate IOTA number input field GATRMAST 9/2014 

Core  Addition of a Help button at the top of most data entry screen.  Provides instant one-click access to the online 
Execu/Suite Knowledgebase at help.execu-tech.com . 

MENURUN 
MENUSCRN 
MENUHELP 

8/2014 

Hotel CONTROL FILE PRINT - 
ROOM RATES 

New report prints room rates within season rates. 
 
Go to Manager > Print Charge/Payment/Misc. Codes. 

GACTLREP 8/2014 

Hotel EVENTS AND CATERING 
1. Improved interaction between events and groups.  
2. Correct transfer of Group name and address to new event. 
3. Grand Totals added to Event Order (BEO) templates/forms. 

GAMTMAST 
GAMTORDR 8/2014 

Hotel GUEST CHECK-IN 1.  Allow selection from multiple guest reservation forms at check-n. 
2.  For group check-ins, check for duplicate room assignments. GAMMAINT 8/2014 

Hotel GUEST PROFILE SETUP 

Issue the following warning when changing a guest profile name: 
            "***WARNING!*** You are changing the name on an existing profile.  This will change the name for all 
reservations and folios attached to this profile.  if this is a new guest, please create a new profile.  Are you sure 
you wish to change this profile name?" 

GAPROFIL 8/2014 

Hotel GUEST REPORT 
GENERATOR 

Calculate actual posted room revenue for master folios.  Continue to calculate forecasted room revenue for in-
house guests. GAHREP 8/2014 

Hotel RESERVATIONS 
1.  Correct display of total room and tax due. 
2.  Warnings when changing group arrival date for groups when rooms are soft blocked for the group. 
3.  Ability to display a Group note in the reservation entry screen for guests attached to groups. 

GARMAINT 8/2014 

Hotel ROOM AND TAX POSTING 
- NIGHT AUDIT Gives warning to help prevent posting Final Room and Tax twice in the same day. GAROOMU 8/2014 

Hotel 

UPDATE ADVANCE 
DEPOSITS FOLIO / 
REORGANIZE ADVANCE 
DEPOSITS 

Prevents running before Night Audit Reorganize. GARDEPC 8/2014 



POS POS SALES BY ITEM 
(etc.) REPORT Print modifier descriptions with indention for easier reading. GAPOREP 8/2014 

Core START MENU 
The menu style (push button or drop down) may now be configured for each terminal. 
 
System Maintenance > User I.D. Setup > Terminal Records > Menu Mode 

START 
MENURUN 7/2014 

Core CORE PROGRAMS 
UPDATE 

1. New color Palette 
2. Larger application screen size 
3. New default fonts 

START 
MENURUN 7/2014 

Core EDIT HTML DOCUMENTS 
AND FORMS 

Execu/Suite now has its own build-in HTML editor for editing Execu/Suite HTML documents and forms. 
 
Go to: File > Special > Edit HTML Documents/Forms 

ETHTMLEditor 7/2014 

Core EMAIL FORMS  

(Confirmation letters, folios, statements, etc.) 
May now choose MS Outlook or Execu/Tech's ExecEmail client for email forms.  User must configure an SMTP 
email server if not using Outlook. 
 
Use the following MENUINI option:  HOTEL-MAIL-OUTLOOK=YES 
* YES - 'execemail-outlook.exe' is called instead of 'execemail.exe' when sending email documents. Uses MS 
Outlook. 
* NO (default) -  'execemail.exe' is called when sending email documents - configured to use user's SMTP server. 

EXECEMAIL 7/2014 

Hotel AM REPORT 

Now three options for printing revenue averages: 
1. Per room for all revenue lines 
2. Per item for all revenue lines 
3. Per room for room revenue, per item for incidental revenue, per cover for POS revenue. 

GADAILYR 7/2014 

Hotel EMAIL CONFIRMATION 
LETTER 

1.  Add HTML tags for Total room & tax, first night room & tax, total room, total tax, balance due, formatted full 
guest name. 
2.  Improved printing of multiple nightly room rates. 

GARLETTE 7/2014 

Hotel HOTEL / GL INTERFACE 

Ability to enter a default "Guest Ledger GL Account".  If set, you may leave the guest ledger GL account blank in 
charge and payment setup. 
 
Use the following MENUINI option: 
    HOTEL-GUEST-LEDGER-GL-ACCT=xxxxxxxxxx 

GAUPDATE 7/2014 

Hotel PRINTED CONFIRMATION 
LETTER Improved printing of multiple night room rates. GARLEWIN 7/2014 

Hotel REGISTRATION FORM 
1.  Add the following HTML tags to the template: Total room, total tax, deposit required, deposit received, total 
amount due, third party booking number. 
2.  Improved printing of multiple night room rates. 

GAREGWIN 7/2014 

Hotel RESERVATION ENTRY 

1.  Ability to look up by and edit third party booking number.  Reservations > Reservation Search 
2.  Group master folio setup - ability to enter master folio departure date. 
3.  Cannot delete group with soft blocks. 
4.  May specify maximum and minimum amounts to reduce user input error in Advance deposit amount, charge 
and payment amounts.  MENUINI.FIL:  PAYMENT-MAXIMUM-HOTEL=10000 

GARMAINT 7/2014 



Hotel ROOM INVENTORY 
REPORT Option to print guest's package in comment column. GARMINV 7/2014 

Hotel TRAVEL AGENCY ENTRY Add email address to travel agency record. GATMAST 7/2014 

Interfaces IHOTELIER BY 
TRAVELCLICK CRS Full implementation of two-way interface of IHotelier Central Reservations by TravelClick. GARIMPTC 7/2014 

Inventory RECIPE ENTRY May now look up POS items by item code or description. INMMAINT 7/2014 

POS POS ORDER ENTRY 

1.  Provide user-defined maximum and minimum quantity amount filters to reduce user input error.  Any $ 
Amount.  MENUINI.FIL:  PAYMENT-MAXIMUM-POS=1000 
2.  New - Activities advance deposits .  Ability to enter and redeem advance deposits for activities directly in 
POS.  Amount, guest name, date, and number of guests are entered. 
3.  Store number of covers in the POS master folio for HOTEL.  This provides the total covers to be recorded in 
the AM Report for sales from POS. 

GAPOREG 7/2014 

WebRes WEBRES ENHANCEMENTS 

1. Interface directly with Shift4 or Element Payment Services.  If deposit is required, deposit payment is posted to 
advance deposit folio.  If deposit is not required, guest credit card is validated and token is created that may be 
applied later. 
2. Sort room types by price or room type name. 
3. Select packages from drop-down box.  Allow/ disallow certain packages in WebRes.  
4. Allow packages to apply to specific room types in Package Setup. 
5. Improved integration with Guest Profile. 

GAWR*.CGI 7/2014 

Hotel EMAIL CANCELLATION 
LETTER New separate letter to email for cancellations. GARLETTE 3/2014 

Hotel GUEST REPORT 
GENERATOR 

New 'report to generate' option: "Send Emails through ET Connect" 
New option to create an email campaign and import directly into ETConnect email processor. GAHREP 3/2014 

Hotel MARKET SEGMENT 
REPORT Add option to not print sub-totals. GAMARKET 3/2014 

Hotel TIME AND ATTENDANCE Expand work code capacity from 20 to 40. GAPOEMP 
GAPOEMPR 3/2014 

POS PRINT ITEM LIST New option to export the menu item list to a tab delimited file. GAPOREP 3/2014 

Hotel 7-30 DAY FORECAST 
REPORT 

1. Expand ability to select up to 40 Source and Market segment codes. 
2. Ability to include selected other revenue to ADR calculation. GAR30DAY 1/2014 

Hotel GUEST HISTORY FOLIO 
DISPLAY 

1. Expand screen size. 
2. Display primary and secondary payment information. GAHMAINT 1/2014 

Hotel GUEST REPORT 
GENERATOR 

1.  Add profile tab 3 and 4 to the tab delimited file version. 
2. Add option to print by date reservation booked. 
3. Add booking window to totals. 
4. Add average length of stay to totals. 

GAHREP 1/2014 

Hotel GUEST SELECTION 
SCREEN - FRONT DESK Option to sort display by guest name or room number. GASELGSM 1/2014 



Hotel GUEST TRIAL BALANCE 
REPORT Add ability to print report for any of the last 30 days. GAGTRBAL 1/2014 

Hotel GUESTS IN HOUSE 
REPORT Option to print guests by package. GAGINH 1/2014 

Hotel RESERVATION ENTRY 
1. Add option to restrict number of days in the future to book reservations. 
            MENUINI option: HOTEL-RES-FUTURE-DAYS=* 
2. Group arrival date changes - improve the way group blocks move when a group's arrival date changes. 

GARMAINT 1/2014 

Hotel RESERVATION STATUS 
REPORT Add ability to print by guest company. GARSSTAT 1/2014 

Hotel SOURCE OF BUSINESS 
ANALYSIS New Report - similar to Market Segment Analysis GASOURCE 1/2014 

 

 

 

 

 

 

 

 

 


